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Overview
StatTrak for Football is a Football Statistical Management System for 
conference, league, tournament, and individual teams.    Keeps records for up
to 100 teams per directory (99 players per team).    Tracks passing, receiving,
rushing, defense, kicking, returns, team record, game results, and team 
standings.    All StatTrak reports can be computed for any combination of 
games.    You can design and save your own report formats, name additional 
categories, and sort on any category.    Reports can be printed or saved to 
disk.    This program will be upgraded every year!

Unless this is a demo (shareware) version of StatTrak for Football, you must 
have either purchased it from an authorized retail outlet or directly from ALL-
PRO Software.    Otherwise, you must immediately register with ALL-PRO 
Software or delete the program.    See the Registration Section for 
registration details and benefits.
Start the program and select one or more teams.    Select Update from the 
Main Menu to update game and player results.    Select Reports from the Main
Menu to display and print the passing, receiving, rushing, defense, kicking, 
returns, team record, game results, and team standings reports.
Back up your data regularly to protect against loss due to power failure, disk 
damage, or other mishaps.    This is very important!



First Game
To add your first game, select "Team 1", or another team,    from the list of 
teams.    Then from the Update Menu, select Team Name and assign the team
name, select Roster and add players to the roster, and then select Games 
and add the game and player results for the first game.    When adding a 
game, all game and player results are optional and can be added, changed, 
or deleted at a later time.
You might want to set up your game types, name additional categories, and 
change your data directory before adding your first game.    Select Name Your
Own from the Options Menu to set up your game types and name your own 
categories.    Select Data Directory from the File Menu to select the directory 
you want to store your team and player files.



Select Teams
StatTrak lets you select one or more teams on the team list.    If you select 
more than one team, only the first team selected on the list can be updated.  
However, you can report on more than one team at a time.    If you select 
more than one team, the Game Scores and Record options on the Reports 
Menu will be disabled.    If you select just one team, the Standings menu 
option will be disabled.    The Passing, Receiving, Rushing, Defense, Kicking 
and Returns menu options are available regardless of how many teams you 
select.
To select multiple teams, click and drag on the team list.    The Shift+click or 
Shift+arrow key extends the selection from the previously selected item to 
the current item.    Ctrl+click selects or deselects an item on the list.



File
Selecting File from the Main Menu provides the following menu options:

Data Directory - Select team and player file directory.
Back Up Files - Back up team and player files.
Restore Files - Restore team and player files.
Exit Program - Exit StatTrak for Football Program.



Back Up Files
Select Back Up Files from the File Menu to make a copy of your team and 
player files for your current working directory.    You might want to make a 
backup copy to a floppy disk and to your hard drive.    This way you have a 
backup copy you can quickly restore from on your hard drive and a copy on a
floppy disk that you can use should you ever experience problems with your 
hard drive.
If you plan to track your statistics on two computers, like home and work, 
you can back up your team and player files to a floppy disk and then load 
them to the other computer using the restore function.
StatTrak will NOT make a directory for you.    You must do it.



Restore Files
Select Restore Files from the File Menu to load a backup of your team and 
player files to the current working directory.    You can restore from a backup 
made to a floppy disk or another directory on your hard drive.
If you plan to track your statistics on two computers, like home and work, 
you can back up your team and player files to a floppy disk and then load 
them to the other computer using the restore function.
StatTrak will NOT make a directory for you.    You must do it.



Help
Select Help Topics from the Help Menu to run the StatTrak for Football Help 
Program.    Select About from the Help Menu to view the About Screen which 
shows the version number of StatTrak for Football and the All-Pro Software 
address.



Reports
To display reports, select one or more teams, select Reports from the Main 
Menu, and then select one of the following menu options:

Passing - Passing Statistics Report.
Receiving - Receiving Statistics Report.
Rushing - Rushing Statistics Report.
Defense - Defense Statistics Report.
Kicking - Kicking Statistics Report.
Returns - Returns Statistics Report.
Game Scores - Game Scores Report (if one team selected).
Record - Team Record Report (if one team selected).
Standings - Team Standings Report (if two or more teams selected).

ALL StatTrak reports can be computed for any combination of games (i.e. all 
games, last 10 games, games 5 through 10, league games, etc.) and can be 
printed or saved to a disk file.



Passing, Receiving, Rushing, Defense, Kicking and Returns Reports
Select    Passing, Receiving, Rushing, Defense, Kicking or Returns from the 
Reports Menu to display team and player statistics.    The reports will show 
players from one or more teams depending on the number of teams 
selected.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.    Click Sort to sort the report on any 
category in ascending or descending order.    The sort selection is saved to 
disk.    Click Format to select, add, change, or delete a report format; select 
the categories you want on the report in the left to right order you want 
them; select one category to create a category report.    Report formats are 
saved to disk.    Click Player to display an individual's game by game 
statistics.    Click Minimum to divide the report into two groups based on a 
minimum number of games.
Use the vertical and horizontal scroll bars to scroll up/down and left/right on 
the report.    The scroll bars will only appear if scrolling is needed.    For 
example, if only three players appear on the report, the vertical scroll bar will
not be visible.
See Passing, Receiving, Rushing Defense, Kicking or Returns Statistics for a 
list of all categories that can appear on the reports and how they're 
calculated.
To view career statistics for a player, select two or more teams and then 
compute the Passing, Receiving, Rushing, Defense, Kicking or Returns 
Report.    Then click Compute and enter a player's name or number and click 
OK. The report will display a statistics line for each team the player appeared
in as well as a total line.    For example, if Jeff Elwood played on the 1996 
Warriors and the 1997 Warriors, you would select both teams, compute the 
Passing Report, and then recompute the report for Jeff Elwood to see his 
1996, 1997, and career passing statistics.



Game Scores Report
Select Game Scores from the Reports Menu to display game results.    The 
report is only available if one team was selected.    The Game Scores menu 
option will be disabled if two or more teams were selected.
Click Print to print the report or save it to a disk file .    Click Compute to 
compute the report for different games.      Click Short to display a one line 
game description which displays game number, game date, game type, 
opponents, and the score.    Click Long to display a more detailed game 
description which also shows the game location and a game comment.    Both
reports can be printed.



Team Record Report
Select Record from the Reports Menu to display the won/lost record for the 
selected team.    The report is only available if one team was selected.    The 
Record menu option will be disabled if two or more teams were selected.
Games won, games lost, win percentage (Pct), points for (PF), and points 
against (PA) are displayed for each game type with recorded games and for 
total games.    Points for are the points the selected team has scored and 
points against are the points allowed by the selected team.    A column for 
ties will only be displayed if ties exist.
Win percentage in computed as ((wins + ties) / total games) where wins are 
1 point, ties are 1/2 point, losses are 0 points, and total games are 1 point 
per game.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.



Team Standings Report
Select Standings from the Reports Menu to display team standings.    The 
report is only available if two or more teams were selected.    The Standings 
menu option will be disabled if less than two teams were selected.
Teams are listed in order of winning percentage.    The report displays games 
won, games lost, win percentage (Pct), winning or losing streak (Streak), 
points for (PF), points against (PA), and games behind (GB) for each of the 
teams selected.
Points for are the points scored by a team and points against are the points 
allowed by a team.    A column for ties will only be displayed if ties exist.
Streak is the latest consecutive number of wins or losses by a team.    For 
example, if a team has lost its last 5 games then the Streak is "Lost 5".    If a 
team won its last game but lost the game before that, the Streak would be 
"Won 1".
Win Percentage is computed as ((wins + ties) / total games) where wins are 1
point, ties are 1/2 point, losses are 0 points, and total games are 1 point per 
game.    Note that a team could be listed first because they have the highest 
win percentage and still be 1/2 or more games behind.    For example, a 1-0 
team will be listed first but will be 1/2 games behind a 3-1 team.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.
To create team standings, game scores must be recorded for all teams 
selected.    ONLY GAME SCORES are needed to create standings.    Game 
location, date, etc., are not needed.    Passing, receiving, and rushing results 
are also not needed.    However, each team must be added to StatTrak.    If 
team X plays team Y, you must add a game for team X and add a game for 
team Y.    Games for both teams can not be added at the same time.    They 
must be added separately.



Compute Reports
From ALL StatTrak reports, you can click Compute to recompute the report 
using the following selection criteria on the Compute Screen:

*    Game Range - Any range of games from 1 to 999.
*    Game Types - Any combination of seven game types    (renamed from 

Name Your Own).
*    Special Select - Check box to use ONLY Special Selected games. Lets 

you compute for non-consecutive game numbers (i.e. 1,3,9).    You can 
Special Select games when updating a game on the Game Screen or by 
selecting games on the Compute Screen.    Selections are saved to disk.

*    Career Statistics - Enter player name or number to compute career 
statistics.    Only available from the Passing, Receiving, Rushing, 
Defense, Kicking or Returns Reports when two or more teams are 
selected.

Click All from the Compute Screen to reset parameters for computing all 
games.    Click OK to compute report.



Print Reports
All StatTrak reports (Passing, Receiving, Rushing, Defense, Kicking, Returns, 
Game Scores, Record, and Standings) can be printed or saved to a disk file.
When you print a report, you can either use the default report title or enter 
your own.    You can select from 1 to 50 copies and select the number of lines 
per page.    You can also select the font size for the report title and main body
of the report.    Some printers will not recognize font size but the report will 
still print.    Bold fonts can also be selected.    For the passing, receiving, 
rushing, defense, kicking and returns reports, you can choose to print just 
the top X number of players (i.e. League Leaders Report).
You can choose to create a report disk file instead of printing the report.    
Entering a file name will override printing.    You can specify a path with the 
file name and can either create a new report file, replace a report file, or 
append to an existing one.    Click Find... to search for a file.
Click Setup to bring up the Print Setup Screen to change printer parameters.



Update
To update team, player, and game information, select Update from the Main 
Menu and select one of the following menu options:

Games - Update team and player results.
Roster - Update player information on roster.
Team Name - Assign or change team name.
Change Player Number - Change player number.
Delete Files - Delete all data files (team name, roster, game 

results, player results) for the selected team.
A team must be selected before the menu options for Update are enabled.    
If more than one team is selected, only the first team selected on the team 
list can be updated.
* See also First Game.



Update Games
Select Games from the Update Menu to update game results.    The two 
components in updating a game are the Game Screen and the Player Screen.
General game information is (optionally) entered on the Game Screen and 
player passing, receiving, rushing, defense, kicking and returns results are 
(optionally) entered on the Player Screen.
After selecting Games from the Update Menu you will advance to the Game 
Menu.    Click Add Game to add a game.    Highlight a game on the Game List 
and click Change to change a game,    click Delete to delete a game, or click 
Insert to insert a game.    You can also double-click a game on the Game List 
to change it.    Clicking Add Game, Change, or Insert will take you to the 
Game Screen.      If you just want to update player results for a game already 
added, you can highlight the game on the Game List and then click Player 
Screen to go directly to the Player Screen.    When you delete a game, ALL 
player results recorded for that game will also be deleted (be careful)!
From the Game Screen, you can update game date, game location, 
opponents, points scored by quarter for the selected team and opponents, 
home team, Special Select, game type, and game comment.    All entries on 
the Game Screen are optional, except game type.    Click OK to update game 
results.    When adding or inserting a game, clicking OK will automatically 
take you to the Player Screen.    However, when changing a game, clicking 
OK will take you back to the Game Menu.    Click Player Screen to advance to 
the Player Screen when changing a game.
One of seven game types is selected for every game updated (defaults to the
first game type).    Game types can be renamed by selecting Name Your Own 
from the Options Menu.    All StatTrak reports can be computed by game type.
For example, you could name game type 1 CONFERENCE and game type 2 
TOURNAMENT.    Then you would select the CONFERENCE game type when 
updating conference games and the TOURNAMENT game type when 
updating tournament games.    Then you could compute any report for only 
conference games, only tournament games, or both conference and 
tournament games.
If you are tracking statistics or standings for two teams that played each 
other, you don't need to enter the same Game Screen information for both 
teams.    Add the game for one team first.    Then on the Game Screen for the 
other team select the opponent from the Drop Down List Box and then click 
Import to initialize the game information (date, location, points by quarter, 
game comment (optional), game type) from what was entered for the other 
team.
On the Game Screen you can check Special Select, which is used in 
computing reports.    For example, you could Special Select night games and 
then compute any report for night games.    You can also Special Select 



games from the Compute Screen.
The other component in updating a game is the Player Screen where 
individual passing, receiving, and rushing results are entered.    Entering 
player results is optional.    You can always add results later.
Click on the Player Table to select a player to update.    Click the "PASS" 
column to update passing statistics, "REC" column to update receiving, 
"RUSH" column to update rushing, "DEF" column to update defense, "KICK" 
column to update kicking, or "RET" column to update returns.    The row 
clicked determines which player is selected.    The area of the Player Table 
selected will be highlighted and the player name and appropriate categories 
will be displayed on the right.    A Football Icon indicates player results have 
been entered.    Click Roster to add players to the roster.    The total number 
of players with passing, receiving, rushing, defense, kicking and return 
results are displayed below the Player Table.
Click the Player Table to select a player and passing, receiving, rushing, 
defense, kicking or returns mode, and then enter the player results (possibly 
from a score book).    Keying into any field will mark the player (Football Icon 
on Player Table and "Played in Game" Checked) as appearing in the game.    
Check "Played in Game" to mark appearance of player in game (you might 
want to give a receiver an appearance even though all categories could be 
zero - never had a pass thrown to him).    Uncheck "Played in Game" to 
remove appearance of player in game and to zero all entry fields.
Click Team Totals to display the team totals for passing, receiving, rushing, 
defense, kicking or returns.    This can be used as an auditing tool.    Click 
Game Screen to go to the Game Screen.    Click OK to save all the player 
results entered.    Click Cancel to cancel ALL the player results entered (not 
the last player entered but ALL the players entered).    Clicking OK or Cancel 
will return you to the Game Menu.
When entering passing, receiving, rushing, defense, kicking, and return 
results you can record results for up to 5 Name Your Own categories.    These 
category names can be changed by selecting Name Your Own from the 
Options Menu.
See Passing, Receiving, Rushing, Defense, Kicking and Returns Statistics for 
lists of all statistics that can be recorded and computed by StatTrak for 
Football.



Update Roster
Select Roster from the Update Menu to set up and maintain a team roster.    
Up to 99 players can be added for each team.    Select from the player list 
and enter or change the name, phone number, address, city, state, zip, and 
other player information.    Click Delete to delete a player name and related 
information from the roster.    Click Print to print the roster.
Player names have an associated player number from 1 to 99.    One way to 
assign player numbers is to use the player's uniform number.    Currently, the 
only use of the player number is for computing career statistics.    However, 
career statistics can also be computed by player name.    The player number 
is used by StatTrak to identify players and does not appear on any reports.    
Deleting a player or changing a player name has NO effect on results 
recorded for that player number.    Player results relate to the player number, 
NOT the player name.



Update Team Name
Select Team Name from the Update Menu to assign or change a team name.  
You can assign a long team name and a short team name.    The short team 
name is only used on multiple team passing, receiving, and rushing reports.   
The long team name is used on all other reports and screens.    Click Default 
to assign the default team name based on the team number (i.e. Team 7).    
You might want to include the year in the team name for documentation 
purposes (i.e. 1997 Warriors).    This is especially helpful if you plan to record 
games for the same team in more than one year.
You might want to assign the team name before you set up the roster or add 
game results to make sure you're working with the correct team - the team 
name is listed on all update screens.    Changing the team name has NO 
effect on game and player results recorded for that team.    Game and player 
results relate to the relative team number, NOT the team name.



Change Player Number
Select Change Player Number from the Update Menu to move a player's 
name and statistics to another player number on the roster.    You can only 
change a player's number if NO results have been recorded for the number 
you want to change to.    This function could be used so a player has the 
same number every year for computing career statistics by player number.    
However, you can also compute career statistics by player name.
Player numbers do NOT appear on any reports.    Don't get hung up on the 
player number.    It's a throw back from the DOS version of StatTrak for 
Baseball from which this program was cloned and will probably be eliminated
in a future version of StatTrak for Football.



Delete Files
Select Delete Files from the Update Menu to delete the team name, roster, 
game results, and player results for the selected team.    This function could 
be used to delete games that were added while experimenting with the 
program.
BE VERY CAREFUL USING THIS FUNCTION.    The team name, roster, 
game results, and player results recorded for the selected team will be 
permanently deleted!
Periodically make a backup copy of your game and player files.



Options
Selecting Options from the Main Menu provides the following menu option:

Name Your Own - Name your own game types and categories.
The next version of StatTrak for Football will probably have an additional 
option to Create Your Own Statistics.



Data Directory
Select Data Directory from the File Menu to select the team and player file 
directory you want to work with.    Each directory can track up to 100 teams.
StatTrak will NOT make a directory for you.    You must do it.



Name Your Own
Select Name Your Own from the Options Menu to name game types and 
additional passing, receiving, rushing, defense, kicking and return categories.
With StatTrak every game is assigned a game type.    With Name Your Own 
you can name up to 7 game types.    For example, you could name game 
type CONFERENCE and game type 2 TOURNAMENT.    Then you would select 
the CONFERENCE game type when adding conference games and the 
TOURNAMENT game type when adding tournament games.    You could then 
compute statistics for conference games by only selecting the CONFERENCE 
game type on the Compute Screen, tournament games by only selecting the 
TOURNAMENT game type, or conference and tournament games by selecting
the CONFERENCE and TOURNAMENT game types.    When computing reports,
only the relative position of the selected game types are important, the 
names are just labels you assign.
With Name Your Own you can also name up to 5 additional passing, 
receiving, rushing, defense, kicking and return categories.    To track dropped 
passes, you could name a category DP and then record results under that 
heading when adding player results.    Then by selecting DP on the Format 
Screen, you could dropped passes to the Receiving Report.    Naming a 
category is for labeling purposes only.    Statistics relate to the relative 
position of the Name Your Own category, NOT the category name.
You might want to name your own game types and additional passing, 
receiving, rushing, defense, kicking and return categories before you start 
adding games.    However, you can name your own game types and 
categories at any time.



Passing Statistics
Below is a list of the Passing Statistics that are tracked and computed by 
StatTrak for Football:

Att    Attempts          FD        Passing First Downs
Cm Completions                                    Sk        Sacks
Yds Total Passing Yards F Fumbles
TD Passing Touchdowns        FL        Fumbles Lost
Int    Interceptions                              Pen        Penalties
Lg Longest Pass                          Xpt        Passing Extra Points
Big Big Plays (your decision)
P1, P2, P3, P4, P5    User Named Categories (renamable)
G        Games                              = number of games appeared in
Pct        Completion Percent = Cm / Att
Avg      Yards per Completion    = Yds / Cm
Pts    Total Points by Passing = (TD x 6) + (Xpt x 2)
Rtg      NFL Quarterback Rating = step 1: ((Cm / Att) - .3) / .2

= step 2: ((Yds / Att) - 3) / 4
= step 3: (TD / Att) / .05
= step 4: (.095 - (Int / Att)) / .04
= step 5: (sum steps 1 to 4) x 100 / 6
= note: steps 1 to 4 can not be < 0 or > 2.375

* See also Rushing, Receiving, Defensive, Kicking and Return Statistics.



Receiving Statistics
Below is a list of the Receiving Statistics that are tracked and computed by 
StatTrak for Football:

Rec      Receptions                Big        Big Receptions (your 
decision)
Tgt Target (times thrown to) FD Receiving First Downs
Yds Total Receiving Yards F Fumbles
YAC Yards After Catch FL Fumbles Lost
TD Receiving Touchdowns Pen Penalties
Lg      Longest Reception Xpt        Receiving Extra Points
C1, C2, C3, C4, C5      User Named Categories (renamable)
G        Games                              = number of games appeared in
Y@C Yards at Catch = Yds - YAC
Avg Yards per Reception = Yds / Rec
Pts Total Receiving Points        = (TD x 6) + (Xpt x 2)
FD% First Down Percent    = FD / Rec

* See also Passing, Rushing, Defensive, Kicking and Return Statistics.



Rushing Statistics
Below is a list of the Rushing Statistics that are tracked and computed by 
StatTrak for Football:

Rsh      Rushes                FD        Rushing First Downs
Yds Total Rushing Yards F Fumbles
YdL Yards Lost FL Fumbles Lost
TD    Rushing Touchdowns Pen        Penalties
Lg        Longest Run                                      Xpt        Rushing Extra
Points
R1, R2, R3, R4, R5      User Named Categories (renamable)
G        Games                              = number of games appeared in
Avg Yards per Carry = Yds / Rsh
Pts Total Rushing Points        = (TD x 6) + (Xpt x 2)

* See also Passing, Receiving, Defensive, Kicking and Return Statistics.



Defensive Statistics
Below is a list of the Defensive Statistics that are tracked and computed by 
StatTrak for Football:

Sol Solo Tackles                F        Fumbles Recovered
Ast        Tackle Assists        FC        Fumbles Caused
Int      Interceptions                Sk        Sacks
Blk Blocked Passes TD        Defensive Touchdowns
Hur Hurried Passes Pen        Penalties
D1, D2, D3, D4, D5      User Named Categories (renamable)
G        Games                              = number of games appeared in
Tkl        Tackles = Sol + Ast

* See also Passing, Rushing, Receiving, Kicking and Return Statistics.



Kicking Statistics
Below is a list of the Kicking Statistics that are tracked and computed by 
StatTrak for Football:

XB      Extra Points Blocked
Xpt Extra Points Attempted/Made and Percentage
Pnt      Punts                PFC Punts Fair Caught
PB    Punts Blocked PTB Punt Touchbacks
P20 Punts Inside 20 PLg Longest Punt
FG All Field Goals Attempted/Made and Percentage
F20 Up to 20 Yard Field Goals Attempted/Made and Percentage
F30 21 to 30 Yard Field Goals Attempted/Made and Percentage
F40 31 to 40 Yard Field Goals Attempted/Made and Percentage
40+ 40+ Yard Field Goals Attempted/Made and Percentage
FGB Field Goals Blocked FLg Longest Field Goal
K1, K2, K3, K4, K5      User Named Categories (renamable)
G        Games                              = number of games appeared in
PAv Punt Return Average = Total Punt Yards / Pnt

* See also Passing, Rushing, Receiving, Defensive and Return Statistics.



Return Statistics
Below is a list of the Return Statistics that are tracked and computed by 
StatTrak for Football:

PRt      Punt Returns                KRt Kickoff Returns
PFC Punt Returns Fair Caught KFC Kickoff Returns Fair Caught
PF      Punt Returns Fumbled KF Kickoff Returns
PTD    Punt Returns for TDs KTD Kickoff Returns for TDs
PLg      Longest Punt Return KLg Longest Kickoff Return
PYd Punt Return Yards KYd Kickoff Return Yards
T1, T2, T3, T4, T5      User Named Categories (renamable)
G        Games                              = number of games appeared in
PAv Punt Return Average = PYd / PRt
KAv Kickoff Return Average = KYd / KRt

* See also Passing, Rushing,    Receiving, Defensive, and Kicking Statistics.



Technical Support
For technical support:

* Call us at 608-271-1586.    Please don't use our 800 number which is 
reserved for orders.

* Fax us at 608-277-9195.
* Write us at All-Pro Software, 30 Maple View Court, Madison, WI 53719
* Email us at jeff@allprosoftware.com



Other Programs
* StatTrak Address Manager $39.95

Address and phone software for managing names, addresses, phone 
numbers, birthdays, anniversaries and printing labels.    You can even 
import names and addresses from other StatTrak Databases.

* StatTrak for Baseball/Softball $69.95
* StatTrak for Basketball $69.95
* StatTrak for Hockey $69.95
* StatTrak for Volleyball $69.95
* StatTrak for Soccer $69.95
* ALL-PRO Tournament Scheduler $69.95

Create and print single and double elimination tournament charts in 
minutes. Seed randomly or manually. Easy to use!

* ALL-PRO League Scheduler $69.95
Create round-robin schedules in minutes!    Handles division play and 
tracks scores and standings.

$4.95 shipping and handling per order!
To order or for more information, call ALL-PRO Software at 800-SPORT-59 
(MC/Visa/Amx/Discover).    International orders are welcome - call 608-271-
1586!
Check out our Home Page (demos available for downloading):

www.allprosoftware.com
or Email us:

jeff@allprosoftware.com
Let us know what other features and sports programs you would like to see!



Registration
Unless this is a demo (shareware) version of StatTrak for Football, you must 
have either purchased it from an authorized retail outlet or directly from ALL-
PRO Software.    Otherwise, you have an illegal copy and must immediately 
register with ALL-PRO Software or delete the program.
To register an illegal copy of StatTrak for Football, call ALL-PRO Software at 
800-SPORT-59 (MC/Visa/Amx/Discover) or send a check or money order for 
$69.95 + $4.95 to ALL-PRO Software.    You will receive the latest version of 
StatTrak for FREE.    International orders please send the check or money 
order in U.S. funds drawn on a U.S. bank.    Wisconsin Residents please add 
5.5% sales tax.
To register a retail copy of StatTrak for Football, send the registration card or 
proof of purchase to ALL-PRO Software if you wish to receive the benefits 
listed below.    No fee is required.
If you obtained the program from ALL-PRO Software, you are automatically 
registered and will receive the benefits listed below.
Registration Benefits:

*    You will be notified when major upgrades to StatTrak for Football are 
released.    They will be offered to you at a reduced price.    The program 
will be upgraded every year.

*    You will be notified when other programs are released or upgraded by 
ALL-PRO Software.

* You can receive FREE technical phone support at 608-271-1586.    Please 
don't call the 800 number which is reserved for orders.    Thank you!



License
THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING ITS MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.      NEITHER ALL-PRO SOFTWARE NOR ANYONE ELSE 
INVOLVED IN CREATING, PRODUCING OR DELIVERING THIS SOFTWARE SHALL BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF USE OF THIS SOFTWARE OR INABILITY TO USE THIS 
SOFTWARE.      IN NO EVENT SHALL ALL-PRO SOFTWARE'S LIABILITY FOR ANY 
DAMAGES EVER EXCEED THE REGISTRATION FEE, REGARDLESS OF THE FORM OF 
CLAIM.    THE ENTIRE RISK AS TO QUALITY AND PERFORMANCE IS WITH THE USER.
THIS AGREEMENT SHALL BE GOVERNED BY THE LAWS OF THE STATE OF WISCONSIN 
AND SHALL INURE TO THE BENEFIT OF ALL-PRO SOFTWARE.    ANY ACTION OR 
PROCEEDING BROUGHT BY EITHER PARTY AGAINST THE OTHER ARISING OUT OF OR 
RELATED TO THIS AGREEMENT SHALL BE BROUGHT ONLY IN A STATE OR FEDERAL 
COURT OF COMPETENT JURISDICTION LOCATED IN DANE COUNTY, WISCONSIN.    THE
PARTIES HEREBY CONSENT TO JURISDICTION OF SAID COURTS. 
THIS SOFTWARE AND THE DISKS ON WHICH IT IS CONTAINED IS LICENSED SOLELY 
TO YOU ON A PERPETUAL BASIS FOR YOUR OWN USE. THIS IS COPYRIGHTED 
SOFTWARE.    YOU ARE NOT OBTAINING TITLE TO THE SOFTWARE OR ANY 
COPYRIGHT RIGHTS.    YOU MAY NOT SUBLICENSE, RENT, LEASE, CONVEY, MODIFY, 
TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, DECOMPILE, OR 
DISASSEMBLE THE SOFTWARE FOR ANY PURPOSE.    RECEIPT AND USE OF THE 
PRODUCT IS YOUR AGREEMENT TO THE TERMS OF THIS LICENSE.




